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ER230 HV Sequencer User Manual 

INTRODUCTION 
This manual is intended to allow the user to install, check and run the system it provides detailed 
information on the system and its operation. Please read this manual carefully prior to beginning 
operation. 
The ER230 High Voltage Sequencer provides the following functions: 

 Two independent Programmable metered HV supplies. 
 Two independent Voltmeter or Ammeter functions 
 Safety Interlock system 
 Software system to allow arbitrary sequences of Voltages to be programmed and generated  

Meet the eDAQ HV Sequencer 
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ATTENTION - READ THIS FIRST:  SAFETY ISSUES - CAUTION 
This equipment generates high voltages of up to 5000Volts DC at currents of up to 500 microamps. 
Making contact with such voltages can be extremely dangerous and all precautions must be taken to limit 
injury in case contact with a live HV circuit is inadvertently made. 
 
Ensure that the HV circuits are housed in an insulated enclosure fitted with an Interlock safety circuit and 
with no manual access to HV circuits while circuits are alive. 
 
Ensure that the safety interlock circuit is connected to the HV Sequencer and is only active and enabled 
when no accidental access to High Voltage circuits can be made. 
 
Other safety precautions: 

 Wear rubber soled footwear 
 Ensure floor is dry 
 Stand on a rubber mat when in the vicinity of high voltages 

 
eDAQ has taken considerable precautions to ensure that no accidental application of HV can be made to 
unprotected circuits. This will in some circumstances prevent the unit from operating but there is usually a 
good reason why the system does not connect the High Voltage supplies – in such events checks all 
settings and safety interlocks. 

What is an INTERLOCK? 
An interlock is a mechanical or electrical system that prevents the inadvertent operation of a potentially 
dangerous system function. 
 
In the case of the eDAQ HV Sequencer this is achieved by using a switch located in the enclosure in which 
high voltages are active.  This switch is connected via a cable to the front panel INTERLOCK BNC in such a 
way that the switch is only closed when no access is available to the High voltages inside the enclosure. 
 
For example with the eDAQ supplied ET225 Micronit Chip Electrophoresis Platform, high voltages can 
only be applied when the top cover is in place.  This is detected and the interlock switch enabled to allow 
the application of high voltages. 
 
If the user is providing the MicroChip enclosure then it is the user’s responsibility to provide the required 
interlock function. 
 
To test the Interlock function it is sufficient to apply a short circuit across the INTERLOCK BNC input pins.  
This should only be done with no connections to the High Voltage input connectors. 

ER230 System Indicators 
System indicators as shown in the preceding diagram provide a direct indication of system operation that 
reflects the state of the internal hardware.  These indicators will assist you in monitoring system operation 
and in diagnosing problems – study them carefully:   
 
INTERLOCK LED: Amber LED 
 FLASHING = Interlock open, unit disarmed, arming not enabled. 
 OFF = Interlock in place and enabled, unit can be ARMED. 
 ON = Interlock in place, unit armed and ready for operation. 
 
SYSTEM STATUS LED: RGB LED (Multicoloured) 

GREEN when “on line” and ready as a Master 
BLUE when ready as a Slave 
 

METER FUNCTION LED: RGB LED 
GREEN:  Safe (disconnected)  
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YELLOW:  Current Mode 
BLUE:  Voltage mode 

 
HV STATUS: RED LED 

OFF: supply disconnected 
ON: supply connected and active. 

 
NOTE 1: On power up the system performs a startup test and flashes the front panel LEDs through the 

various colors available for display. 
 
NOTE 2: In some cases where the HV supply needs to be used in proximity to light sensitive detectors it is 

possible to optionally turn off all the LEDs to maintain low background illumination. 
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Hardware Installation  
ATTENTION: When installing the system for the first time ALWAYS perform software installation before 
connecting the hardware units.  This ensures that the correct drivers are installed  
  
After carrying out the software installation described in the next section, perform the following Hardware 
installation procedure. It will confirm that: 

 That safety interlocks are in place and functioning correctly 
 The units can be armed and disarmed 
  

It is advisable to perform this operation first on a single system and then repeat it with a master/slave 
arrangement if such a configuration is required. 

Single Unit Operation 
 Connect the unit to the 12V DC mains power pack. 
 Connect the unit to the PC using the USB cable provided. 
 Safety Issue: Connect the unit to a good ground using the terminal post on the rear of 

the unit. 
 Turn Power ON. 

INTERLOCK LED will flash if interlock is not enabled. 
HV Status LEDs: Off (no HV output) 
STATUS LEDs: Green 

TEST INTERLOCK Function 
This function can be tested without any software running: 

 The INTERLOCK LED will initially be flashing. 
 Connect a short circuit to the INTERLOCK BNC. 
 INTERLOCK LED will turn OFF. 
 Press the ARM Push Button for approximately 1 to 2 seconds.  You will hear an audio warning 

that the HV has been armed (enabled) and the INTERLOCK LED will turn ON. 
 At this point all HV supplies are still inactive but are in a state where they can be set and 

controlled by the Sequencer Application software. 
 Pressing the Arm button again will DISARM the HV Sequencer, and the INTEROCK LED will turn 

off. 
A short press off the Arm button will always disable all outputs from the HV Sequencer. 

To direct ground 
connection 

To PC USB 
connection 

To Power 
Adapter 
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Connecting 2 units as Independent units 
Two units can be operated independently with each connected via its USB cable to the PC. No I2C 
connection should be made between them, as it will cause a conflict between two.  All control and 
configuration of each unit is performed via the eDAQ Sequencer Software.  The Sequencer software 
needs to be started twice, selecting a different COM port in each. 

Connecting 2 units as Master/Slave 
 Connect 12V power to both units. 
 Safety Issue: Connect both units to a good ground using the terminal post on the rear 

of the unit. 
 Connect your computer’s USB to the unit that will become the MASTER. 
 Connect the supplied I2C cable from the “output” of the MASTER to the “input” of the SLAVE. 

This cable provides communication functions between the units. 
 Turn on both units.  The SLAVE unit’s STATUS LED will turn go blue to indicate that the unit has 

been configured as a slave, and is connected to the MASTER. 
  

A maximum of 2 units can be connected together in a Master/Slave arrangement. There is no physical 
difference between a master and slave unit, so they can be connected either way around.  However, it is 
important to connect the USB cable to the unit which has the I2C cable connected to its “output” 
connector. 
 
The required connections are shown in the diagram below.  
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Note on INTERLOCKs 
The system is provided with a number of safety features or Interlocks: 

 Chip adapter interlock:  The chip adapter used should provide a safety contact interlock to 
indicate that the microchip adapter is safe for use.  This interlock is a contact closure switch, 
which is closed when the HV circuit is fully enclosed and protected from user access. This 
interlock is connected to the front panel Interlock BNC and indicates to the ER230 that it is safe 
to arm the system. 

 USB Present:  The system cannot be ARMED without an active USB connection 
 Software Control: Once the system is ARMED High Voltages can only be applied under 

software control. 
 ARM circuit: prior to applying HV to an external circuit the system must be armed by the user 

by depressing the front panel ARM push button for approximately 2 seconds. 
 DISARM: The system can be disarmed by a momentary push of the ARM button. 
 Power Overloads:  the circuit detects power overloads and situations that lead to the 

generation of arcs (sparks).  The system will switch itself off in such circumstances and in such 
circumstances may require to be reinitiated with power being turned on Off and On. 

 Master/Slave Configuration:  In a Master/Slave configuration, both interlock inputs must be 
connected and the system will not operate until safety conditions are met for both units 
simultaneously. 

 
CAUTION:  Do not disconnect HV leads by hand while High voltages are present – this is extremely 
dangerous and can cause harmful arcs to be generated. To disable power use the ARM/DISARM front 
panel button or the software’s Disarm or Disconnect menu items 
 
You should now be in a position to Install and operate the HV Sequencer Application which will allow 
you to generate and output a sequence of High voltages. 
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Software Installation & Operation 

eDAQ Sequencer  Overview 
eDAQ Sequencer is a Windows application that provides the means to setup a series of steps that are 
executed under computer control.  The following functions are provided: 
 
System setup and sequence entry: The software identifies system configuration on startup and allows the 
operating parameters to be set immediately. 
 
Table driven Sequence: A time based table is filled out, specifying that the operations to be performed in 
sequence.  This includes setting of HV supplies to new voltages, trigger and digital I/O line functions. The 
following sequence operations are implemented:  
 
Time: set to xxxx seconds 
Meter 1&2: Disconnect, Read V, Read I 
Output1&2: Set V=xxxx (V and I monitored), Read V, Read I 
Digital Out: Low/Open, High/Closed, Short Pulse, Long Pulse 
Special commands: Wait for trigger, Wait for Arming, Go Safe 
New functions can be readily added to meet customer requirements 
 
Digital outputs can be used to control external devices or the recording of data in an ecorder. 
 
Monitoring: Once a sequence is started the user is able to observe the progress of the sequence on the 
sequence table.  Values of HV supply voltages and currents are displayed during operation. 

Installing the HV Sequencer software 
Insert the HV Sequencer installation disk into your computer.  It is recommended to install the software 
before plugging in the hardware, as it ensures the drivers are correctly installed. 
 
The eDAQ Sequencer Setup Wizard will display the following start-up screen; follow the prompts to 
install the program. 

     Start up screen 
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      Final Start up screen 
 
If the “Run eDAQ Sequencer box” is ticked the application will be launched when the installer is closed. 
  

 HV Sequencer Main Window 
 

  

Communication 
The HV sequencer uses a virtual USB serial communications (COM) port.  When the ER230 hardware is 
first attached to USB, a free COM port number is automatically assigned by Windows.  That COM port 
will be then used every time that unit is plugged in again. 
 
Note:  the first time you connect the system to the computer it may take some time for the system to 
identify the HV sequencer device driver and install it.  You will be notified when the device is ready. 
 
The first time you use the sequencer software, you need to specify the COM port that the hardware has 
been assigned.  Select the Preferences option in the File menu, then choose your HV Sequencer in the 
list at the top – see screen shot below. This preference is automatically saved for future use 
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 Preferences panel 
 
If you are uncertain about which COM port to assign use, the Serial Port Monitor application can help 
identify the COM port assigned to the HV sequencer. This small application is included on the HV 
Sequencer software CD, and can also be downloaded from the eDAQ Utilities and Tools download 
webpage: 
 
 http://www.edaq.com/utilities_tools.php 
 
The serial port monitor runs as an icon in the notification area.  Clicking on it will show a list of eDAQ 
COM port devices attached to your computer. 
 
The other Preference options set the digital output type, and provide control over front panel lights in 
situations where light pollution needs to be kept to a minimum. 
 
Check if you have installed an interlock as described previously.  The INTERLOCK LED should be OFF 
indicating that the INTERLOCK is in place. 

    
 
Click the Online in the menu bar to attach the selected ER230 unit to the Sequencer application.  
 
Click the Offline in the menu bar to disconnect the selected ER230 unit from the Sequencer application. 
  

   
 

Disarming and Interlock Test 
 
Press and hold the red ARM button to arm the unit.  As before, the unit will beep and arm itself.  This will 
also be shown in the software’s display. 
 
You can now disarm the unit by either: 

 Pressing the red ARM button again 
 Clicking “Disarm” in the top-right of the software window. 

 
While the unit is armed, you can test the safety interlock by removing the short-circuit from the BNC 
connector.  The unit should immediately disarm itself, disconnecting the outputs, and turning off any 
applied voltages. 
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Manual Settings 
After arming the unit, click on the More… button to display the controls for making immediate changes 
to the unit. 
 
The right hand side of the HV Sequencer setup panel provides the means to manually set meter 
functions, output voltages, and the digital outputs’ states.  Make some selections, and then click on Set.  
The ER230 hardware will immediately apply the settings you have chosen, and the software will display 
your choices, along with readings of current and/or voltage. 
 
At this point  the system will indicate the voltages set and currents measured.  Since no loads are yet 
connected, the currents will be very near zero.  
 

  Setup panel 
 
At any time, pressing the Disarm button in the top-right hand corner of the Main Window or the red 
button on the front panel of the ER230 will disarm the unit and make it safe.   
 
After disarming, you must press and hold the red button (as before) to re-arm it.  The software can not 
re-arm the device. 
 
Outputs let you control the digital outputs of the unit.  In the preference you can set Output 
configuration as contact closure, or TTL. 

HV Sequences 
The lower area of the Setup panel provides the means to define a “program” or “sequence” to run. This 
consists of a number of timed steps, each of which can update the state of one or more of the individual 
functions or outputs.  There are also some “special” commands that can be carried out. Unused 
connections can have the width of their columns reduced by dragging their column separator. 
 
All changes on a step happen simultaneously (within 2 milliseconds). 
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  Setup screen with an example 
 
Here is another example program: 
 

 
 
If a step doesn’t have anything entered in its box, the output will remain unchanged from its previous 
setting. 
 
A time of “0” means “immediately upon starting”, and the times are cumulative, measured from when 
the sequence was started,  i.e.: the delay between the first four of the lines above is 5, 3, and 4 seconds 
respectively. 
 
It is recommended to have the first row setting every output to a known state, in case the previous run 
was stopped part-way through, leaving the unit in an unknown state. 
 
When the program finishes, the unit will be left in whatever state it was at the end.  It will not 
automatically disconnect or disarm the outputs, unless explicitly told to do so. 

The Meter channel functions are: 

Disconnected: Disconnected from the front panel terminal (LED GREEN) 
Read V: Voltmeter connection (LED BLUE) 
Read I:  Current Meter connection (LED YELLOW) 

The Output channel functions are: 

Disconnected: Disconnected from the front panel terminal. 
Read V: Voltmeter connection (LED BLUE). 
Read I: Current meter connection (LED YELLOW) 
Set V: Set the voltage to the value entered in the second column – In this mode the Voltage 
indicated will be the actual voltage produced within 1%. (LED RED) 
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Digital outputs can be set to: 

Low/Open: Output goes low or open, as per the “digital output mode” setting in Preferences.  
High/Closed: Output goes high or closed. 
 

The type of digital output, TTL or Contact Closure, is set from the Preferences dialog in the File menu. 
 

Special is a special function to be performed.  You can either: 
Disarm: Disconnect HV supplies, and stop the program. 
Wait for trigger: Pause, and wait for a high/close on the rear panel’s green connector “Trigger” 
pins. 

 
Simple editing commands are available on the Edit menu.  The option to Always show the slave will 
force the display of the second control panel and additional program columns, even if a second unit is 
not attached. 
 

 
 
Programs can be saved and loaded using the menu options in the File menu.  
 

   
 
Once you are satisfied with your program, click the Run button in the menu bar.  The software will step 
through the program, executing each step at the given time after starting. 
 

Current Polarity Convention

- Neg Current  + Pos Current  



Page 16  ER230 User Manual EDID-00397-MAD 
 

 
 
The Pause button can be used to pause running of the program.  The Run button changes to a Resume 
button, which you can click to continue execution. 
Stop will stop execution, but it will leave the unit in the current state, with whatever voltages selected 
still being output. 
The Disarm button will stop any running program and put the ER230 hardware into a safe state. 
Various fault and safety switch conditions will also force a disarming (and termination of program), 
including: 

 USB cable being removed 
 Front panel safety interlock opened/removed 
 Front panel red button being pressed 
 When operating with a slave unit, disconnection from the slave unit 

Modes of Operation 
General:  
Disarmed/Safe – High voltages and meters disconnected   
Armed- High voltages are active and available for connection to external circuit. 

Programmable HV power supplies.  
Output Voltage:  Adjustable from 200V to 3000V @600μA (lower voltages and higher voltages are 
available)  
Output Polarity:  Positive or Negative with respect to the common ground potential 

Operating Modes:  
O/C mode: Circuit disconnected by high voltage relay. 
Voltage Mode: Voltage mode with current and voltage monitoring 
HiZ Mode: Voltage monitoring – 10Meg impedance 
S/C Mode: Short circuit to ground with current monitoring 

Meters 
Operating Modes 
O/C mode: Circuit disconnected by high voltage relay 
HiZ Mode: Voltage monitoring – 100Meg impedance 
S/C Mode: Short circuit to ground with current monitoring  
 
By combining the HV power supplies and meters it is possible to setup the conditions which load the 
sample into the separation channel and then apply the appropriate voltages to cause separation and 
detection of the sample components as shown in the example. 
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Typical Installation 

 

SAMPLE PORT 
INJECTION Cycle Voltage Mode @800V 
SEPARATION Cycle Hi Z mode

BUFFER WASTE Port 
INJECTION Cycle  HiZ mode 
SEPARATION Cycle S/C mode 

BUFFER Port 
INJECTION Cycle HIZ mode 
SEPARATION Cycle 
Voltage Mode @2500V for 300 sec 

SAMPLE WASTE PORT 
INJECTION Cycle S/C Mode for 180sec 
SEPARATION Cycle Hi Z mode



Page 18  ER230 User Manual EDID-00397-MAD 
 

ER230 HV Hardware 

ER230 HV Channel Block Diagram 
A Block diagram of a HV supply channel is shown below; there are two identical HV channels in each 
ER230unit: 

 

ER230 Meter Channel block diagram 
 

 

V

I

HV Relay 
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Voltage 
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Current Monitor

Voltmeter input Impedance = 100MΩ
Current sensor burden = 10Ω Current 
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3000V 
3W  
Isolated 
Power 
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Voltage 
Monitor 

Current 
Monitor 

ER230 High Voltage Channel block diagram
Voltmeter input Impedance = 10MΩ 
Current sensor burden = 10Ω 
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Green Connector Pin Numbers 
 

 
 
ER230 HV Sequencer “green” connector Pin functions 
 

1 TRIG + TTL  IN 11 Meter 1 E Meter 1 Voltage 

2 TRIG - TTL COM 12 Meter 1 I Meter 1 Current  

3 HV2  E HV  E MONITOR 2 13 CTL1 + DIGITAL  IN/OUT 1 

4 HV2  I HV CURRENT MONITOR2 14 CTL1 - DIGITAL COM 

5 COM COMMON 15 CTL2 + DIGITAL  IN/OUT 2 
6 HV1 E HV E  MONITOR1 16 CTL2 - DIGITAL COM 

7 HV1  I HV CURRENT MONITOR1 17 CTL3+ DIGITAL  IN/OUT 3 

8 Meter 2 E Meter 2 Voltage 18 CTL3 - DIGITAL COM 
9 Meter 2  I Meter 2 Current 19 CTL4 + DIGITAL  IN/OUT 4 

10 COM COMMON 20 CTL4 - DIGITAL COM 

 
Note: 
Digital I/O pins are implemented as contact closure or TTL outputs, software selectable 
Trigger input can be a contact closure or TTL input 
HV E MONITOR scale factor: 500mV/kV 
HV Current Monitor Scale factor: 1000mV/mA 

 1                     5                          10                        15                         20 
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Specifications 

HV Supply Specifications and options 
Model Max Output Min output Max Current Operating Modes  Ripple 
   
UR2 +/-2000V +/-150V  +/-1450μA Voltage, O/C and S/C  0.1%  
UR3* +/-3000V +/-200V +/-600μA  Voltage, O/C and S/C .1%  
UR5 +/-5000V +/-250V  +/-550 μA Voltage, O/C and S/C  0.2%  
 
Output is referred to system common (Case Ground) 
*Standard configuration – other configurations available on special order. 
 
Load regulation: <2% specified for 20-90% full load:  
Rise and Fall times: <5mS specified for changes within the same polarity regime. 
Mode Change: <100mS due to relay operations, safety and software latency 

Safety Features: 
Interlocks: an interlocks is provided on the mechanical case to ensure that no voltages are present with 
the case open unless authorized maintenance is in progress.  An interlock is also provided on the 
microchip environment to ensure that accidental contact is not made with the high voltages.  It is the 
responsibility of the user to ensure that adequate protection is provided on the equipment provided by 
the user. EDAQ provides Microchip adaptors with appropriate interlock features. 
Arm/disarm switch: This switch needs to be held for 2 second to arm the system and allow high 
voltages to become active.  Any short contact on the ARM switch will cause the system to be disarmed. 

 Meter Functions 
Voltage Mon Voltage Mon Current Mon Current Mon  
Range  Resolution Range  resolution 

Meter 1, 2 +/-5000V +/- 1V  +/-2000μA +/-1 μA  
Output 1, 2 +/-5000V +/- 1V  +/-2000 μA  +/-1 μA  
 
Displayed resolution limited to +/- 1 unit 

Communications and Inputs and outputs terminals 
 
Daisy Chain connectors: Twin DB9 connectors allow two (2) ER230 units to be daisy chained together. 
USB Port:  Compatible with USB1 & USB 2 and provides,  communications facility to PC’s 
Output and Meters front panel connectors:  SHV (Safe High Voltage)  type  
20 Way 3.5mm Green screw terminal: 4 x Digital I/O lines, Trigger TTL or CC, 4xVoltage Monitor 
signals, 4xCurrent  Monitor signals. 
System/Chassis Earth terminal: 4 mm screw terminal. 

System Indicators. 
 
The following LED front panel displays are available. 
 
SYSTEM STATUS LED: RGB LED 

GREEN when “on line” and ready as a Master 
BLUE when ready as a Slave 
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INTERLOCK: Amber LED 
FLASHING = Interlock open, unit disarmed, arming not allowed. 
OFF = Interlock OK, unit disarmed 
ON = Interlock OK, unit armed and ready for operation. 

 
METER FUNCTION: RGB LED 

GREEN:  Safe (disconnected)  
YELLOW:  Current Mode 
BLUE:  Voltage mode 
 

HV SUPPLY FUNCTION: RGB LED 
GREEN:  Safe (supply disconnected)  
YELLOW:  Current Mode 
BLUE:  Voltage mode 

 
HV SUPPLY STATUS: RED LED 

OFF: supply disconnected 
ON: supply connected and active. 

Physical: 
Dimensions (w x h x d):200 x 65 x 250 mm (7.9 x 2.6 x 9.8 inch) 
Weight: 3.00 kg packed 
Operating temperature 0-35ºC 
Humidity: 10 to 80% non condensing  
Power:  9-16Volts @ 2 Amps max supplied by mains powered AC/DC converter (supplied) 
 


